
Belajar Audition - Membuat audio untuk karaoke 

Dalam tutorial kali ini kita akan membuat sebuah audio yang bisa digunakan untuk 
karaoke, kita mengedit right dan left channel. Pembaca yang budiman, selamat berjumpa 
kembali dengan saya pada tutorial Adobe Audition. Sebagai awal , saya ingin bertanya kepada 
anda? Sukakah anda dengan musik? Pernahkah anda bermain musik? Dapatkah anda mengedit 
musik? Saya yakin semua orang pasti suka dengan music, tapi sayangnya tidak semua orang bisa 
bermain musik dan tidak semua orang dapat mengedit musik. Nah, pada perjumpaan kali ini saya 
ingin mensharing pengalaman menggunakan Adobe Audition.   

Saya yakin semua orang pengedit musik ( music editor ) pasti tahu tentang Cool Edit Pro, 
tetapi banyak yang tidak mengenal Audition, Audition adalah versi baru dari Cool Edit Pro. 
Sejak tahun 2002 – 2003 Adobe mengambil alih Cool Edit Pro dan me-restructure ulang dengan 
memberi nama Audition dan hingga sekarang Audition versi terakhir adalah versi 3. 

Pernahkah anda mendengar kata ‘karaoke’? Karaoke identik dengan menyanyi. Nah, jadi 
di sini kita akan membuat sebuah audio untuk menyanyi / karaoke. Dalam sebuah audio karaoke 
biasanya audionya hanya berupa instrument saja, tapi kadang juga instrument dan vocal dari 
penyanyinya dapat dimunculkan. Jadi intinya kita membuat sebuah audio karaoke yang mana 
audio yang kita buat dapat disetting oleh orang orang yang ingin berkaraoke, bisa dihilangkan 
vocal nya, dan sebagainya. Oke, langsung saja mari kita bahas tahap demi tahap.  
 
Langkah 1 : Silahkan buka Adobe Audition anda. 
 Adobe Audition disini tidak dibundled dengan CS5, jadi bisa anda lihat pada gambar dibawah 
bahwa software ini standalone. CS5 lebih menyukai Adobe Soundboth untuk mengedit audio 
ketimbang Adobe Audition. Lalu kenapa saya memilih audition? Kenapa tidak soundboth saja 
dalam tutorial ini. Soundboth hanya untuk pengguna yang simple saja. Audition memiliki fitur 
fitur untuk para pengedit audio professional. 
Langkah 2 : persiapkan file audio yang akan kita jadikan audio karaoke.  
Untuk membuat Audio Karaoke, maka yang harus kita persiapkan adalah: 
1. file audio untuk instrument 
2. file audio untuk vocal. Atau bisa juga: 
1. file audio instrument dan vocal 
2. file audio instrument saja. 
Saya harap anda pernah berkaraoke sehingga tahu apa yang saya maksudkan pada statement di 
atas. Konsep audio karaoke adalah pada pengaturan mixer output, jadi bila right channel anda 
minimumkan dan left channel tetap, maka biasanya akan muncul instrument saja jadi anda dapat 
berkaraoke ria menggunakan suara anda, bila left channel kita minimkan dan right channel pada 
possisi normal, maka muncul instrument sekaligus  Pada gambar diatas terlihat bahwa saya akan 
membuat sebuah audio karaoke lagu gedung tua, disini saya punya instrument lagu gedung tua 
dan vocal gedung tua. Nah, nanti akan kita mixing terlebih dahulu instrument dan vocalnya. Oh, 
ya, hampir lupa, pada tutorial kali ini perlu saya ingatkan bahwa saya membahas cara membuat 
“Audio untuk karaoke” bukan video. Untuk membuat video karaoke akan kita bahas pada 
tutorial selanjutnya di Adobe Premiere Pro. 
 



Langkah 3 : mari mixing file instrument dan vocal. Untuk audio karaoke kali ini kita akan 
mengisi left channel dengan vocal + instrument, sedangkan untuk right channel kita akan 
mengisinya dengan instrument saja. Jadi nantinya bila anda ingin berkaraoke tinggal 
meminimumkan left channel anda. “di sini kita mengopen file file yang kita gunakan pada 
project window. Nah, anda dapat meng-open nya melalui doubleclick pada project window, atau 
dengan mengklik toolbar open, atau bisa juga melalui menu file -> open” 
langkah 4 : Masukkan kedua file ( instrument dan vocal ) ke multitrack. Dalam hal ini kita 
akan menggabungkan file instrument dan file vocal jadi kita harus bekerja dengan multitrack. 
Klik multitrack pada toolbar dan drag file instrument ke track 1, kemudian drag juga file vocal 
ke track 2. Geser/drag file untuk menemukan posisi yang cocok antara instrument dan vocal. 
 
-Langkah  5: export semua file. Di sini kita sudah meng-mixing instrument dan audionya, 
kemudian kita export dengan cara klik menu file ->export -> audio mixdown 
 “pada gambar diatas saya mengsave sebagai file mp3, kemudian memberikan filename 
‘MIXING – instrument – vocal’ , saya juga tidak mengotak atik mix down options, silahkan bila 
anda ingin mengotak atik nya” OKE, SEKARANG kita sudah punya file instrument dan file 
mixing ( instrument dan vocal ), nah kedua file ini lah yang nantinya akan kita gunakan untuk 
membuat audio karaoke. MARI KITA MENGINGAT NGINGAT ke yang sudah saya tuliskan di 
awal, bahwa, sebuah audio karaoke memiliki audio instrument pada salah satu channel dan audio 
mixing (instrument + vocal ) pada channel yang lain. 
Langkah  6 : buat file baru . klik menu file -> new: terlihat default bahwa -sample rate : 44100 
-channels : stereo  
-resolution : 16 bit, Saya sarankan anda memilih default saja. Kalo pengalaman saya, bila 
anda memilih sample rate 48000 ke atas, maka ada beberapa player yang kurang mendukung. 
Dan pastikan juga anda memilih stereo pada channels sehingga option left channel dan right 
channel dimunculkan. Inilah teknik pada audio karaoke, antara left channel dan right channel di 
isi dengan audio yang berbeda , bisa dibilang juga dengan stereo, jadi bila anda dengarkan 
dengan headset maka antara headset kanan dan kiri sudah berbeda soundnya. 
Setelah anda klik OK maka akan muncul otomatis waveform Untitled 
Langkah 7 : Masukkan file audio instrument ke dalam right channel file Untitled. Untuk 
memasukkan file instrument ke right channel-nya file Untitled, maka terlebih dahulu kita harus 
me-select all file instrument. Double click file instrument -> double click pada wave form -> klik 
kanan -> copy 
Langkah 8 : setelah copy file instrument, double click file Untitled, pastekan pada right 
Channel. 
Buka file Untitled dengan mendouble click nya -> click icon right channel pada toolbar-> Klik 
kanan right channel  -> paste.  Perlu diingat yang kita klik kanan disini adalah right channel.: 
Setelah dipastekan pada right channel maka screenshot nya akan menjadi seperti berikut ini 
Langkah 9 : masukkan file audio yang telah kita mixing tadi ( instrument + vocal ) ke 
dalam left channel. Di sini caranya adalah sama dengan saat kita memasukkan instrument ke 
right channel. “oke, copy MIXING – instrument – vocal .mp3 , kemudian click left channel dari 
Untitled, pastekan disana. Caranya sama kan dengan copy paste sebelumnya… 
Dan hasilnya akan tampak seperti pada gambar berikut ini. 
 
Langkah 10 : save as file baru dengan nama yang anda sukai. Klik menu file -> save as -> 
“Oke, audio kita sudah jadi untuk digunakan berkaraok 



Menghilangkan Noise Dan Hum Audio Hasil Rekaman Dengan Adobe Audition 
 

 

Karena sudah banyak yang membahas secara teoritis tentang masalah ini maka disini anda diajak 
untuk langsung praktek memperbaikinya dengan salah satu software audio terkenal Adobe 
Audition. 
Namun untuk lebih fokus dalam perbaikan alangkah baiknya mempergunakan 
Headphone,kecuali anda mempergunakan system speaker audio yang baik atau telinga super 
tajam. 
Silahkan buka Adobe Audition, Masukan Audio yang akan diperbaiki dengan cara klik FILE > 
OPEN > klik dua kali file yang akan diperbaiki atau klik satu kali kemudian OPEN. 

 
 
Perbaikan Noise (ngeresek,ngajeos:sunda)  

Blok dahulu audio yang akan diperbaiki dengan cara klik dan drag dari awal sampai akhir audio 
atau klik dua kali,sehingga terlihat agak buram/samar. 

Untuk yang praktis silahkan klik EFFECT > NOISE REDUCTION/RESTORATION > HISS 
REDUCTION PROCESS. Silahkan pilih presets (1),kemudian klik preview (2) untuk 
mendengarkan perubahan dan klik stop (3) bila akan mengganti presets atau mendengarkan 
perbedaan suara asli dengan suara hasil perbaikan. 
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Atau silahkan anda kreasikan sendiri semua yang berhubungan dengan noise di NOISE 
REDUCTION/RESTORATION,dengan catatan file hasil perbaikan disimpan dengan cara Save 
AS atau membuat folder baru hasil perbaikan agar file asli tidak tertimpa dan anda bisa membuat 
beberapa sample uji coba. 

Perbaikan HUM (ngagerung:sunda) 

 Blok dahulu audio yang akan diperbaiki dengan cara klik dan drag dari awal sampi akhir audio 
atau klik dua kali,sehingga terlihat agak buram/samar. 

Klik EFFECT > OISE REDUCTION/RESTORATION > DEHUMMER 

 



Tentukan presets di 50 Hz AND HARMONICS (1),Number Of Harmonics (2) di angka 1 s/d 
3,klik preview (3) untuk mendengarkan perubahan dan klik stop (4) bila ingin mencoba presets 
lain atau ingin mendengarkan perbedaan suara asli dengan suara hasil perbaikan. 
 
Bila semua keluaran audio dirasa cukup pas dan puas silahkan anda simpan,dan apabila anda 
memiliki beberapa file audio,atau pasti memiliki segudang lagu kesayangan alangkah baiknya 
bila semua keluaran audionya/volume (db) diratakan atau disamakan sehingga keluaran/ke-
kerasan volumenya antara lagu yang satu dengan yang lainnya akan relative sama,untuk itu 
silahkan anda mampir di Cara Mudah Meratakan Output Audio Dan MP3 sehingga lebih 
nyaman ditelinga. 
 

Merubah Format Audio WAV Menjadi MP3 Dengan Adobe Audition CS6  
 
Ini materi sekaligus menanggapi pertanyaan seorang sahabat yang menanyakan bagaimana 
merubah format audio Waveform (WAV) menjadi Moving Picture Experts Group (MP3 atau 
MPEG-1 layer 3),mempergunakan Cool Edit yang sebenarnya kalau tidak salah software ini saat 
ini sudah discontinue karena sudah merger/di-akuisisi oleh Adobe,kalau salah cepat koreksi ya .  

Jadi pada dasarnya kalau anda masih mempergunakan Cool Edit,sebenarnya bisa saja namun 
kemungkinan beda penempatan toolbar anu menu saja dan saya hanya menjawab bahwa 
merubah format audio WAV menjadi format audio MP3 dengan mempergunakan Cool 
Edit..Bisa. 

Namun karena software tersebut tidak terpasang di kompi,terpaksa hanya bisa menjelaskan 
dengan mempergunakan Adobe Audition meskipun pada prinsipnya sama saja,jadi cara merubah 
format audio WAV menjadi MP3 inilah caranya : 

1.Pastikan anda memiliki software Adobe Audition CS6 atau versi di bawahnya juga bisa. 
 
2.Buka software tersebut,dengan klik dua kali icon di desktop atau klik kanan > Open. 
 
3.Masukan file format WAV yang akan dirubah dengan cara,klik > File > Open,cari dimana file 
yang akan dirubah dan bila sudah ditentukan klik dua kali atau klik file tersebut kemudian > 
Open.Untuk lebih cepat membuka file tersebut bisa digunakan tombol CTRL + O. 
 
4.Bila file tadi sudah berada di area edit,klik > File > Save As ,sehingga muncul tampilan 
gambar seperti di bawah : 
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5.Untuk merubahnya silahkan anda klik panah kecil pada menu Format > Pilih MP3 Audio 
(*.mp3),dan jangan lupa tentukan nilai pada Sample Type dan Format Settings dengan klik > 
Change,sehingga seperti contoh gambar di bawah : 

 
Tentukan lokasi penyimpanan hasil kerja anda pada menu Location dan silahkan membaca 
kembali panduan singkat dalam merubah angka-angka di atas yang sangat berpengaruh terhadap 
kalitas audio 6.Klik > Ok,untuk menyimpan hasil kerja anda. 

Demikian selamat menikmati audio MP3 hasil conversi dari format WAV mempergunakan 
Adobe Audition CS6,yang tentu dengan format MP3 selain bisa diputar di semua perangkat 
pemutar audio dan juga ukuran file lebih kecil dibandingkan format audio WAV. Namun dari 
segi kualitas suara WAV lebih baik dari MP3 

  

Menaikan Kekerasan Suara Hasil Rekaman Menggunakan Adobe Audition 
 
Salah satu masalah yang sering terjadi dalam perekaman acara live adalah kurang kerasnya level 
suara hasil rekaman yang dihasilkan,hal ini bukanlah masalah serius dan lumrah terjadi karena 
untuk setting audio terutama Setting Sound System lapangan kadang kita harus menyesuaikan 
dengan kondisi lapangan . 

Dan satu hal yang menarik adalah lebih baik kita merekam dengan input audio kecil,dari pada 
input terlalu besar (Over Load/Clipping),meskipun idealnya sebelum melakukan perekaman 
dilakukan ujicoba terlebih dahulu namun hal ini kadang tidak biasa dilakukan karena melakukan 
perekamannya sendiri biasanya hanya merupakan fun saja tidak seperti mereka yang sengaja 
membuat acara rekaman live professional. 

Jadi bagi anda yang memiliki hasil rekaman acara live suaranya dirasa terlalu kecil,jangan kecil 
hati karena dengan sedikit sentuhan software professional Adobe Audition semuanya akan 
beres,dan akhirnya anda memiliki kualitas level suara yang diharapkan. 

Catatan  
- Sebelum dinaikan level suaranya,bila terdapat NOISE lebih baik hilangkan dahulu (Minimalisir 

- Atau kalau ada gangguan HUM,lebih baik perbaiki dahulu. Namun hati-hati jangan terlalu 
ekstrim,cukup di angka antara 0 s/d 5 atau point 2 saja,karena cara ini bisa memangkas nada 
rendah audio hasil rekaman anda. 
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-Bila anda merekam dengan format audio WAV jangan dirubah menjadi MP3 karena biasanya 
akan terjadi pengurangan durasi,hal ini penting terutama bila audio tersebut digunakan untuk 
suara video (Menghindari delay antara suara dan gambar). 

Menaikan Level Kekerasan Suara Hasil Rekaman Menggunakan Adobe Audition 
1.Buka software Adobe Audition anda 

2.Masukan file yang akan diproses,klik > FILE > OPEN,cari dimana file tersebut disimpan dan 
bila seudah ditemukan,Klik file tersebut > OPEN.atau Klik langsung dua kali file tersebut. 

3.Inilah contoh file format WAV sebelum dinaikan level kekerasannya. 
4.Untuk menaikan level kekerasannya,Klik > EFFECTS > sorot AMPLITUDE AND 
COMPRESSION > Klik AMPLIFY. 
 
5.Pada tampilan EFFECT AMPLIFY,perhatikan BOOST adalah untuk menaikan tingkat 
kekerasan dan CUT adalah untuk menurunkan tingkat kekerasan,silahkan pilih angka yang cocok 
pada item BOOST sesuai tingkat kekerasan yang diinginkan. 
- Pada setiap perubahan jangan dulu di APPLY,tapi silahkan dengarkan dahulu perbedaannya 
dengan tekan tombol PREVIEW Play/Stop (1),dan pastikan tombol TOGGLES The POWER 
STATE (2)posisi ON/nyala hijau. 

- Perhatikan CHECKLIST pada LINKS SLIDERS (3),bila kanal tertentu ada yang ingin 
diturunkan atau dinaikan tingkat kekerasannya maka hilangkan Checklist tersebut dan silahkan 
rubah tingkat kekerasan kanal dimaksud dengan menggeser Slidernya. 

- Bila anda melakukan edit lebih dari satu atau beberapa audio/lagu agar semua keluaran 
audionya relative sama,silahkan simpan setting terbaik menurut anda dengan cara Klik SAVE 
SETTINGS AS A PRESET (4),jadi untuk selanjutnya silahkan cari preset tadi kemudian 
APPLY. 

6. Inilah contoh file format WAV setelah dinaikan level kekerasannya. 

7.Untuk selanjutnya silahkan simpan hasil pekerjaan anda dengan Klik > FILE > SAVE AS 
(CTRL+SHIFT+S) dan beri nama file tersebut (agar tidak menimpa file audio asli),atau kalau 
sudah yakin Klik > FILE > SAVE (CTRL+S). 

 

 

 

 



Manfaatkan Sound Effect Compressor Adobe Audition 

 

Tentu bagi anda yang berkecimpung dalam dunia audio atau pemilik rental Sound System sudah 
mengenal Sound Effect Compressor (Limiter),karena dilihat dari fungsinya alat ini sangat 
penting sekali untuk meratakan signal input agar relative rata dan stabil,namun tentu dibutuhkan 
pengetahuan cara setting yang benar karena kalau salah bisa mengakibatkan suara semakin 
amburadul. 
 
Dan seperti telah saya bahas pada artikel sebelumnya DISINI,alat ini merupakan alat tambahan 
yang harus dimiliki setelah memiliki peralatan standard seperti Mixer Console,Aqualizer,Sound 
Effect dan Crossover,namun disini saya tidak akan membahas bagaimana cara setting alat ini tapi 
bagaimana memanfaatkan fitur Sound Effect Compressor pada Adobe Audition untuk 
memperbaiki/meningkatkan kualitas suara hasil rekaman. 

 

 

Cara Menggunakan Sound Effect Compressor Adobe Audition 

1.Silahkan buka Adobe Audition. 

2.Masukan file audio yang akan diperbaiki,klik > File > Open,pilih file audio yang akan di 
proses kemudian klik > Open,atau langsung klik dua kali file tersebut. 

3.Klik > Effects > Amplitude and Compression > Multiband Compressor > Pop Master > 
Apply. 

Pada menu ini bisa anda coba pula fitur-fitur seperti menambahkan Bass (Enhance Lows),Treble 
(Enhance Highs) dan lain-lain dengan selalu mendengarkan dahulu perubahannya sebelum di 
Apply. 
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4.Silahkan simpan hasil pekerjaan anda dan dianjurkan jangan menggunakan SAVE tapi 
biasakan menggunakan SAVE AS agar file asli tidak tertimpa dan memudahkan untuk 
membandingkan suara file asli dengan file hasil pekerjaan anda. 

Bermain Suara Menggunakan Effect Stretch And Pitch Pada Adobe Audition 
 
Boleh saja saya memberi judul artikel ini dengan kata “Bermain”,namun siapa tahu di tangan 
anda yang penuh imajinasi dan kreativitas akan menghasilkan karya seni profesional yang bisa 
dijadikan lahan bisnis atau usaha yang menghasilkan uang,siapa tahu?. 

Jadi mudah-mudahan setelah membaca artikel sederhana ini akan muncul ide-ide kreative lain 
yang lebih sempurna dengan hanya mengandalkan salah satu fitur yang ada di software pengolah 
suara profesional Adobe Audition yang akan saya bahas di bawah ini. 

Pasti anda sudah tahu atau minimal pernah mendengar lagu-lagu yang dibawakan oleh salah 
seorang penyanyi dengan karakter vokal mirip Muppet?,dan siapa tahu diantara anda ada yang 
masih bertanya bagaimana sih cara membuatnya?,bisakah karakter suara ini dipergunakan untuk 
keperluan lain?,tentu jawabannya Bisa. 

Salah satu ide mungkin bisa digunakan untuk pembuatan KABARET,PARODI atau hal lain 
yang sekiranya dibutuhkan dalam merubah jenis dan karakter vokal,jadi dengan hanya satu atau 
dua pengisi suara saja,anda bisa membuat lebih dari satu tokoh dengan jenis dan karakter vokal 
yang berbeda pula. Namun sebelum melakukan perekaman anda harus menentukan dahulu tema 
kabaret atau parodi tersebut terutama tokoh yang terlibat dalam cerita,misalnya tokoh A,tokoh B 
dan seterusnya hal ini untuk menentukan jenis dan karakter vokal masing-masing tokoh tersebut. 

Untuk cara pembuatan Kabaret atau Parodi bisa anda pelajari Disini,dan untuk materi MP3 bisa 
anda ganti dengan rekaman suara satu atau dua orang pengisi suara,yang nantinya jenis dan 
karakter vokal bisa dirubah seperti cara di bawah ini,dan anda hanya perlu menguasai 
CUTTING,FADE IN atau FADE OUT yang bisa dipelajari Disini. 

Bermain Suara Menggunakan Effect Stretch And Pitch Pada Adobe Audition 

1.Buka software Adobe Audition anda 

2.Masukan file rekaman suara yang akan dirubah jenis dan karakter vokalnya. 

3.Klik > EFFECTS > sorot TIME AND PITCH > STRETCH AND PITCH (Process). 

4.Pada tampilan Effect-Stretch and Pitch,silahkan pilih preset terutama item HELIUM dan 
LOWER PITCH untuk dirubah-rubah jenis dan karakter vokalnya sesuai keinginan anda,atau 
bisa pula menggunakan item lain bila diperlukan. 
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5.Hal yang terpenting,apabila jenis dan karakter vokal masing-masing tokoh telah ditentukan 
anda harus menyimpannya menjadi preset,dengan nama tokoh tersebut misalnya Preset Tokoh 
A,agar di setiap bagian suara tokoh tersebut sama,caranya : 

 
- Kilk > SAVE SETTINGS AS A PRESET,berilah nama sesuai nama tokoh tersebut. 
- Gunakan setiap preset sesuai tokohnya masing-masing. 
6.Gunakan slider untuk menentukan jenis dan karakter vokal yang diinginkan,atau bisa pula 
menggunakan fitur lain yang ada pada menu STRETCH AND PITCH. 
7.SELAMAT BERKREASI. 
 

Kali ini akan saya jelaskan bagaimana caranya menggabungkan,memotong dan menggunakan 
Fade In/Fade Out pada Adobe Audition yang merupakan fitur utama dalam pembuatan materi 
ini,selain masih banyak fitur lain yang bisa dimanfaatkan pula. 

Namun mohon ma’af bila tips ini jauh dari sempurna karena saya bukan akhli dalam bidang 
ini,apalagi seni editing Musik akan tetapi mudah-mudahan akan menjadikan suatu gambaran 
untuk pembelajaran dan pemahaman dalam menguasai fitur Adobe Audition terutama pada 
sesion Multitrack. 
 
Sebelum melangkah lebih jauh alangkah baiknya melakukan beberapa langkah berikut ini 
: 
- Pilih Kualitas musik (Lagu MP3) yang baik,minimal sample rate 41KHz dan bitrate 128 Kbps 
 
- Semua lagu Mp3 diratakan kekerasannya/volumenya,agar setelah digabungkan terdengar 
relative sama,untuk yang belum tahu caranya silahkan masuk DISINI,atau gunakan fitur 
Normalize pada Adobe Audition (Effects > Amplitude and Compression > Normalize). 

- Tentukan urutan lagu MP3,dari awal sampai akhir yang akan disimpan pada track 1,track 2,3 
dan seterusnya. 
 
Langkahnya 
1.Buka Adobe Audition,setelah terbuka klik > Multitrack,silahkan masukan data sesuai 
keinginan anda, 

2.Masukan lagu MP3 yang akan di edit,klik File > Open,dalam keadaan default lagu MP3 masuk 
pada Waveform,maka klik Multitrack > klik lagu MP3 tahan dan geser (Drag and Drop) 
kemudian simpan di kolom track 1 dan track 2 untuk lagu MP3 berikutnya dan seterusnya. 

http://www.mawarnada.com/2012/07/cara-mudah-meratakan-output-audiomp3.html
http://www.mawarnada.com/


3.Tentukan awal dan akhir lagu MP3 pada track 1,bila sudah ditentukan klik kanan pada titik 
area pemotongan > Split > klik kanan sekali lagi kemudian pilih Cut untuk membuang bagian 
lagu MP3 yang tidak diperlukan. 

4.lakukan langkah point 3 pada lagu MP3 di track berikutnya sehingga tersisa bagian lagu MP3 
yang diperlukan saja. 

5.Gunakan Fade In di awal lagu dan Fade Out di akhir lagu bila perlu,untuk memperhalus 
penggabungan bagian lagu MP3,dan upayakan pada penggabungan akhir lagu dan awal lagu 
lainnya mencari nada yang kira-kira pas,misalkan suara akhir kick drum lagu 1 berada di awal 
lagu 2, maka pemotongan akhir lagu 1 sebelum kick drum,atau bisa juga dengan mencari nada 
dominan lainnya seperti Bass gitar dan lain-lain. 

 
6.Fade In > Suara terdengar dari kecil kemudian standard,klik beberapa detik dari awal lagu 
pada garis volume untuk memberikakan tanda batas,kemudian klik diawal lagu pada garis 
volume dan kemudian seret kebawah. 

7.Fade Out >Suara terdengar dari standard menjadi kecil, klik beberapa detik di akhir lagu pada 
garis volume untuk memberikan tanda batas,kemudian klik di akhir lagu pada garis volume dan 
kemudian seret kebawah. 

8.Dengarkan dan putar berulang-ulang hasil pekerjaan anda dan gunakan fasilitas tombol M 
(Mute) dan S (Solo) pada setiap track. Saya yakin anda pasti menghasilkan suatu karya yang 
lebih bagus dan sempurna,karena semuanya tergantung kreativitas apalagi dengan memanfaatkan 
beberapa fitur lain pada Adobe Audition ini,atau mencoba Editor Audio profesional lainnya. 

9.Bila sudah yakin dengan pekerjaan anda,silahkan simpam dalam file format MP3,Klik File > 
Export >Multitrack Mixdown > Entire Session dan tentukan kualitas audionya sesuai selera  

Itulah tips langkah sederhana dalam menggabungkan beberapa file Lagu MP3 atau WAV,yang 
bisa dipergunakan dalam Musik Kabaret atau Parodi Musik,sempurnakan dengan kreativitas 
anda...pasti. 
 
 

 

 

 

 

http://www.mawarnada.com/2012/08/lagu-romantis-pilihan-terpopuler.html
http://www.mawarnada.com/


Belajar Mixing (menyatukan) Musik rekaman 
 

 

 

Mixing adalah suatu istilah umum yang tidak hanya dipakai pada dunia audio saja. Mixing biasa 
juga kita dengar pada ibu-ibu yang lagi membuat adonan kue, alatnya namanya mixer. Jadi 
kegiatan me mix itu adalah kegiatan mencampur atau menyatukan beberapa input yang akan 
dibuat satu dan menjadi nama baru lagi seperti menjadi kue, atau menjadi lagu. Dari mentega, 
garam, gula, air di mix menjadi kue. ok mudah-mudahan sampai disini bisa sedikit lebih 
dikhayalkan.. 

Mixing Audio memerlukan alat yang namanya mixer audio. Karena kita lagi membahas sofware 
maka mixernya juga berupa software juga (sudah menyatu di program adobe audition serta 
program audio lainnnya).Pada tahap mixing musik ini yang akan dicapai adalah: 

1. Penyatuan Volume  Masing-masing Track musik 
2. Panning (pemberian panorama bunyi (Left-Right) untuk masing-masing instrument. 
3. Pemberian efek-efek pada setiap instrumen seperti (efek ruang(reverb), chorus, 

phaser,dll) 
4. Pengkarakteran bunyi (equalizing) setiap instrument  

http://4.bp.blogspot.com/-INvE18WDU4Y/UCNOUaabxwI/AAAAAAAAALA/uwpI5K5PQbY/s1600/index.jpg


 

Tampilan kosong Multitrack adobe audition 

 
Dalam mixing ini level volume masing-masing track harus diperhatikan agar tidak berkurang 
atau lebih dari level seharusnya. (level maksudnya volume dalam satuan db). Panning untuk 
memberikan kesan lebih stereo pada musik kita. seperti kita mendengar suara orang dari jauh 
atau kadang tiba-tiba dia harus terdengar seolah-olah didepan kita. nach proses panning inilah 
yang akan mengatur. Untuk mencapai karakter setiap instrument pada musik kita sesuai dengan 
yang diharapkan, kita harus lebih berhati-hati menyetel dan memberikan efek. Kalau saya pada 
instrumen gitar hanya diberi efek chorus tak lebih tak kurang, reverb (efek ruang) sedikit ajahhh 
tidak sampai terdengar seperti musik jadul banget. 

 

Tampilan multitrack ketika sudah ada isinya 
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Pada tahap ini sebenarnya masing-masing orang punya metode masing-masing dalam mencapai 
musik yang diinginkan dan disukai banyak orang. 

Pada karakter sound zaman sekarang vokal hanya sedikit diberi efek ruang aja tidak menggema 
seolah-olah sang vokalis menyanyi di depan kita , itu adalah pemandangan bunyinya. instrument 
gitar bisa di bawa ke arah kanan atau kiri sedikit dari pendengaran kita. 

Masalah volume masing-masing instrumen biasanya menurut karakter lagu atau genre lagu itu. 
pokoknya ambil aje referensi audio untuk lagu jaman sekarang, banyak mendegar saja. 
 
 

 

Mixernya 

Pada gambar software kita melihat tampilan mixer pada adobe audition versi cs ini,  
 

 

 

Fungsi Equalizer 
 

http://2.bp.blogspot.com/-eIMlXjjAVeE/UCNR-qwgWnI/AAAAAAAAALk/ejYzsgGWLdY/s1600/gambar+4.png


 

http://pas-products.ab-archive.net/graphics/screenshots1 

Dari kata Equal yaitu membagi, sistem Equalier berfungsi untuk membagi frekuensi 
suara.  Equalizer dalam audio berfungsi untuk membagi frekuensi suara yaitu High, Midle dan 
Low Frekuensi. Ini untuk mengedit karakter suara vokal atau suara instrumen musik. Equalizer 
bisa juga dipakai untuk menurunkan noise level. 

 

 

 

Membuat Rekaman Audio Lebih Terdengar Menyatu 
 

Biasanya ketika kita telah proses take lagu, dan sedang melakukan tahap penyatuan 
gelombangnya (editing) atau Mastering, kita selalu mendapati lagu tersebut terdengar tidak 
menyatu dan kering. Suara setiap instrument masih terrpisah satu sama lain. Masalah tersebut 
dapat diatasi dengan penggunaan sistem rak efek pada software yang kita pakai, yakni dengan 
menggunakan kompresi gelombang suara, biasa juga kita kenal namanya seperti Compander, De 
esser dll.  

Efek kompresi ini berguna untuk meratakan gelombang, membuat suara terdengar tebal, tetapi 
perlu diperhatikan jangan sampai berlebih dalam memberikan efek ini, karena bisa-bisa kita 
tidak mendapati dinamika dalam rekaman tersebut, sesuai dengan yang diinginkan. 

Dalam proses penyempurnaan rekaman, anda memerlukan penyetelan Equalizer (frekuensi 
low,midle dan high), proses ini penting untuk mencapai kebutuhan audio yang diinginkan. 
Proses equalizing ini juga diperlukan untuk mengatasi suara-suara yang tidak diinginkan seperti 
noise, kelebihan low frekuensi yang menimbulkan efek pha (artikulasi instrument yang tidak 
diinginkan). 

Pemberian efek ruang seperti reverb pada masing-masing instrumen juga diperlukan. Meskipun 
demikian, anda perlu mempertimbangkan proporsionalnya (kesesuaian dengan kebutuhan). 
Karena model rekaman audio rekaman jaman sekarang tidak terlalu berlebihan dalam pemakaian 

http://dimensiakal.wordpress.com/2011/07/18/pemakaian-compander/
http://dimensiakal.wordpress.com/2011/11/05/mengatasi-suara-desis-noise-dalam-recording-audio/
http://4.bp.blogspot.com/-LOgguqjx0Kc/UJsefy3oX8I/AAAAAAAAAqg/O2d0b6r2hpk/s1600/equalizer.jpg


efek ruang. zaman dulu, pemakaian efek ruang atau biasa disebut efek gema, dipakai juga untuk 
mengatasi kekurangan akibat ruangan tempat mereka rekaman, sangat tak proporsional. Kadang-
kadang diperlukan suara, seperti terdengar sedang berada di dekat pendengar atau bahkan seolah-
olah suara datang dari suatu lembah yang jauh, tergantung kebutuhan anda. 

Memberikan Panning yang baik. Panning adalah panorama audio yang kita berikan pada masing-
masing instrument. Pemberian efek panning ini, menjadikan audio kita lebih mempunyai 
perspektif ruang. Misalnya suara gitar lebih terdengar di kiri, bass di tengah atau di depan kita, 
dan lain-lain. 

• Compander 
• Equalizer 
• Reverb 

 

-         Delay Effects 

Delay Effects adalah pilihan dalam menu ini dapat digunakan untuk memperkenalkan  
serangkaian mengulangi atau gema delayer dari sinyal input asli pada interval  secara berkala 
sepaced atau pengguna didefinisikan. 

Menu pada Delay Effects 

    Chorus digunakan untuk menambah kekayaan suara dengan membuatnya terdengar seolah 
beberapa suara atau instrumen yang dimainkan sekaligus. Chorus adalah cara yang bagus untuk 
menambahkan tingkat "kehadiran" ke jalur yang ada sekarang. Menggunakannya untuk 
memberikan efek stereo ke mono sampel (di mana kiri dan kanan saluran yang identik), atau 
untuk menambah harmoni atau "ketebalan" untuk sebuah lagu vokal. Anda juga dapat 
menggunakan chorusing untuk membuat beberapa efek khusus benar-benar luar dunia ini. 

    Delay  digunakan untuk membuat gema tunggal, serta beberapa efek lainnya. Penundaan 35 
milidetik atau lebih akan dianggap sebagai gema diskrit, sedangkan yang jatuh dalam kisaran 15-
34 milidetik dapat digunakan untuk menciptakan sebuah paduan suara sederhana atau flanging 
efek. (Efek ini tidak akan efektif sebagai paduan suara yang sebenarnya atau flanging efek dalam 
menu Efek, sebagai pengaturan penundaan akan tetap dan tidak akan berubah dari waktu ke 
waktu.) 

    Dynamic Delay  memungkinkan Anda untuk mengubah jumlah penundaan lebih dari panjang 
gelombang. Sebagai contoh, untuk lima detik pertama dari sebuah file audio Anda dapat 
mengalami keterlambatan 2 milidetik, untuk 15 detik berikutnya Anda bisa mengalami 
keterlambatan 20 milidetik, untuk 10 detik berikut menunda bisa di 7 milidetik, dan seterusnya. 



    Echo Fungsi ini menambahkan serangkaian ulang, membusuk gema untuk suara. (Untuk echo 
tunggal, gunakan fungsi tunda sebagai gantinya). 

    Echo Chamber Fungsi Echo Chamber dapat mensimulasikan suasana di hampir setiap 
ruangan. Pengaturan disediakan untuk menentukan ukuran ruangan virtual Anda dan 
karakteristik permukaan, bersama dengan penempatan mikrofon virtual. Jumlah gema dapat 
disesuaikan, sampai sekitar 25.000. Perlu diketahui bahwa gema makin banyak untuk 
menghitung, semakin lama waktu yang dibutuhkan untuk fungsi untuk menyelesaikan. 

    Flanger Untuk menciptakan efek yang sama dengan sedikit menunda dan pentahapan sinyal 
pada interval yang telah ditentukan atau acak. 

    Full Reverb Kendali Reverb, seperti efek Reverb standar, digunakan untuk mensimulasikan 
ruang akustik. Ini juga konvolusi-impuls berbasis (seperti Reverb standar), yang berarti tidak ada 
dering, metalik, atau artefak lainnya terdengar buatan. Namun, beresonansi spesifik dapat dicapai 
jika diinginkan (lihat Warna). 

      Multitap Delay  dapat digambarkan sebagai kombinasi Delay, Echo, Filter, dan efek 
Reverb.Sampai 10 keterlambatan unit dapat dibuat, masing-masing dengan keterlambatan 
mereka sendiri, umpan balik, dan pengaturan penyaringan. 

    Reverb adalah efek digunakan untuk mensimulasikan ruang akustik, dan terdiri dari refleksi 
awal dan gema yang begitu erat spasi bahwa mereka dianggap sebagai suara membusuk tunggal. 
Reverb berbeda dari efek Echo dasar bahwa penundaan tidak diulang pada interval teratur spasi. 

    QuickVerb Seperti dua efek reverb lain (Kendali Reverb dan Reverb), QuickVerb 
memungkinkan Anda untuk menambahkan gema untuk audio Anda untuk mensimulasikan ruang 
akustik yang berbeda. Namun, karena tidak konvolusi berbasis seperti Full Reverb dan Reverb 
(yang membutuhkan lebih banyak kekuatan untuk menjalankan, sehingga meningkatkan beban 
pengolahan pada sistem Anda) QuickVerb lebih cepat untuk digunakan. Ini berarti bisa diubah 
lebih cepat dan efektif dalam lingkungan multitrack real-time, tanpa perlu untuk "mengunci" 
efek untuk melacak. 

    Sweeping Phaser Seperti efek Flanger, Phaser memperkenalkan sebuah fase pergeseran-
variabel menjadi sinyal split dan recombines itu, menciptakan efek-efek khusus yang 
dipopulerkan oleh gitaris dari tahun 1960-an. The Phaser Penyapuan menyapu takik atau 
meningkatkan filter jenis bolak-balik tentang frekuensi pusat. 

Filters 

Filters adalah untuk memodifikasi sinyal pada konten frekuensi. 

Menu pada Filters 

 



    Dynamic EQ  memungkinkan Anda untuk mengubah jumlah pemerataan atas panjang 
gelombang. 

    FFT Filter Sifat grafis dari FFT (Fast Fourier Transform) Filter memudahkan untuk 
menggambar kurva atau takik untuk menolak atau meningkatkan frekuensi tertentu. 

    Graphic Equalizer Dengan Graphic Equalizer, Anda dapat meningkatkan atau memotong 
sinyal pada pita frekuensi tertentu, dan memiliki representasi visual dari kurva EQ secara 
keseluruhan. Berbeda dengan Equalizer Parametrik, yang Equalizer Graphic menggunakan pita 
frekuensi preset kontrol untuk pemerataan frekuensi cepat dan mudah. 

    Graphic Phase Shifter Fase ini shifter Grafika memungkinkan Anda menyesuaikan fase 
gelombang dengan menambahkan titik kontrol untuk grafik. X-axis (tepi horisontal) dari grafik 
langkah-langkah konten frekuensi gelombang, sementara itu grafik sumbu y (sisi vertikal) 
menampilkan derajat fase ke pergeseran, dengan nol derajat tidak mewakili pergeseran fasa. 

    Notch Filter ini menghilangkan hingga enam pengguna didefinisikan frekuensi, di samping 
telepon standar nada DTMF. Gunakan penyaring ini jika Anda ingin menghapus band frekuensi 
yang sangat sempit. Misalnya, Anda dapat menghapus 60Hz hum sementara meninggalkan 
semua 59Hz dan 61Hz audio tersentuh. 

    Parametric Equalizer Parametrik digunakan untuk mengedit denda frekuensi dalam suara. 
Mereka berbeda dari equalizers yang menawarkan sejumlah tertentu dari frekuensi dan 
bandwidth Q (yang menentukan berapa banyak frekuensi keseluruhan akan dilakukan oleh 
kontrol, satu frekuensi yang dipilih) di bahwa mereka memberi Anda kontrol terus atas 
frekuensi, Q, dan pengaturan gain. 

    Quick Filter pada dasarnya, ini adalah fungsi cepat dan mudah untuk mengubah nada sampel 
Anda untuk membuatnya lebih menyenangkan telinga. 

    Scientific Filters menyediakan high-order IIR (Infinite Impulse Response) filter untuk lulus 
tepat band, band menolak (takik), atau tinggi atau low pass filter. 

Restoration 

Menu pada Restoration 

Click/Pop Eliminator bekerja dengan mencari anomali dalam data audio yang dapat ditafsirkan 
sebagai klik atau muncul (Deteksi), dan kemudian mengganti atau memperbaiki lokasi yang 
rusak (Koreksi). Jika Anda ingin membersihkan rekaman vinyl sebelum mentransfernya ke CD 
atau media digital lainnya, Klik / Pop Eliminator adalah efek untuk digunakan. Ini lebih akurat 
dari sekadar memotong klik, atau mengganti data dengan garis lurus. Anda dapat memperbaiki 
seluruh pilihan atau langsung menghapus satu klik jika ada yang disorot. 



    Clip Restoration dapat menghapus kejadian kejahatan kliping dari bentuk gelombang Anda. 
Hal ini dilakukan dengan benar-benar "mengisi" segmen terpotong gelombang. 

    Hiss Reduction secara harfiah mengukir mendesis menjengkelkan dari kaset rekaman, album 
rekaman (setelah menggunakan Klik / Pop Removal), atau rekaman mikrofon. Ini akan 
menghapus semua audio di semua frekuensi yang berada di bawah ambang tertentu (yang 
umumnya lantai tingkat kebisingan atau mendesis). Jika audio memiliki desis latar belakang 
konstan, maka yang dapat mendesis "kebisingan gated" atau dihapus sama sekali. Setiap audio 
dalam pita frekuensi lebih keras dari tingkat cutoff akan tetap tak tersentuh. 

    Noise Reduction secara dramatis dapat mengurangi kebisingan latar belakang dan broadband 
umum dengan minimal pengurangan kualitas sinyal. Hal ini juga dapat menghapus mendesis 
tape, mikrofon kebisingan latar belakang, 60 siklus dengungan, atau suara yang konstan di 
sepanjang durasi gelombang Anda. 

-        Special 

Special adalah pilihan dalam menu ini dapat digunakan untuk memperkenalkan beberapa effeck 
pengolahan yang baik inovatif dan liar-n-fangky. 

    Menu pada Special 

    Convolution adalah efek dari mengalikan setiap sampel dalam satu gelombang atau impuls 
oleh sampel yang terkandung dalam bentuk gelombang lain. Dalam arti tertentu, fitur ini 
menggunakan satu gelombang untuk "model" suara dari bentuk gelombang lain. Hasilnya dapat 
bahwa penyaringan, bergema, fase pergeseran, atau kombinasi dari efek tersebut. Artinya, setiap 
versi disaring dari bentuk gelombang dapat bergema di setiap penundaan, setiap beberapa kali. 

    Distortion  fungsi CoUse ini untuk menciptakan efek tersebut sebagai pembicara mobil ditiup, 
mikrofon teredam, dan amp overdrive. Bersenang-senang membuat suara audio Anda benar-
benar JELEK! (Tentu saja, it's great untuk menambahkan bulu untuk gitar menjilat untuk 
mendapatkan yang "asli" suara logam berat.) 

-       Time/Pitch 

Time / Pitch dalah Pengaruh dalam menu ini untuk digunakan untuk mengubah waktu  (diration) 
dan pitch (nada suara) dari file audio atau kisaran yang dipilih. 

Menu pada Time / Pitch 

 

    Doppler Shifter  untuk menciptakan "terbang dengan" suara yang paling dikenal dari mobil 
balap oleh atau pesawat terbang. Mari kita gunakan mobil untuk contoh kita. 



    Pitch Bender  Efek ini bervariasi yaitu pitch sumber audio dari waktu ke waktu. Gunakan 
grafik untuk "menarik" tempo Anda untuk membuat perubahan tempo halus atau efek, seperti 
sebuah catatan atau rekaman mempercepat atau memperlambat. 

    Stretch adalah Perubahan Regangkan efek pitch (frekuensi) dan / atau tempo (durasi) dari 
sinyal audio. Hal ini juga dapat mengubah pitch atau tempo baik tanpa mempengaruhi yang 
lain.Misalnya, Anda dapat menggunakan Peregangan untuk transpose lagu ke tombol yang lebih 
tinggi, atau memperlambat sebuah bagian bawah tanpa mengubah pitch. 
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